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1 General Notes 

1.1 Trademarks 

All trademarks or brand names including those protected for third parties shall 
unconditionally be subject to the provisions of the applicable laws governing trademarks and 
the proprietary rights of the registered owners. All trademarks, brand names or firm names are 
or may be trademarks or registered trademarks of their respective proprietors and are used 
only for description and unique identification. All rights not explicitly granted here are 
reserved.  

Failure to explicitly identify trademarks used in this manual does not indicate that a name is 
free from rights of third parties.  

Allen-Bradley®, ControlLogix®, CompactLogix™, MicroLogix™, RSLogix™ 500, RSLogix™ 5000 
are trademarks of Rockwell Automation®, Inc. 

EtherNet/IP™ is a trademark of ODVA, Inc. 

1.2 Liability 

SIKO GmbH assumes no warranty whatsoever regarding topicality, correctness, completeness 
or quality of the information or software products provided. All liability claims against SIKO 
GmbH referring to material or immaterial damages caused by using or not using the 
information or software provided or by using erroneous or incomplete information or software 
are always excluded. 
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1.3 Limitations 

This example and its function were tested on a MicroLogix™ 1400 1766-L32BWA. The module 
was programmed using RSLogix™ 500 version V9.05.01 (CPR 9). 

Controlling I/O with explicit messages is relatively complex compared to normal implicit I/O 
control known from ControlLogix® and CompactLogix™ controllers. The MicroLogix™ 1400 
controller supports only explicit messages. 

You can control the drive with a MicroLogix™ 1400 controller with the following limitations:  

• An explicit message is a much slower form of control and is nondeterministic. 
This means that you cannot guarantee how long the drive will take to start up or stop 
when the command is given. Therefore, all equipment used in this manner should be 
subject to a risk assessment, taking into account the mechanical and electrical 
implementation. 

• A timeout value (in milliseconds) in the drive will issue a drive fault if a message is not 
received from the controller within the specified time. However, the controller has no way 
of detecting a loss of communication to the drive until the next cycle of explicit messages. 
This is another factor in the risk assessment. 

• Any additional drives to be controlled will require additional explicit messages for their 
control, and they need to be carefully sequenced. Most controllers have small 
communication queues (see its user manual), which need to be carefully managed if 
messages shall not get lost. 

• Each controller has a limited number of communication connections (see its user manual 
for maximum connections), which will limit the number of drives that can be connected. 

1.4 Requirements 

• AG2X firmware version C/V 01.05 upwards. 

• Basic knowledge of handling and programming Allen-Bradley® systems. 

• Familiarity with EtherNet/IP™. 

1.5 Versions Overview 

This manual is related to the example project “SIKO_AG2X_RSL500_example_V100”. 

1.6 List of Abbreviations 

EIP EtherNet/IP™ 

SW Status Word 

CW Control Word 
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2 Example Ladder Logic Program 

Functions of the example: 

• Data exchange using explicit messages 

• Read/write the Configuration Assembly 

• Mapping of the Control and Status Word  

2.1 Create a New Project 

1. Start RSLogix™ 500 software. 

2. Execute the command “File” > “New”. 

3. Enter “PLC1” into the “Processor Name” field. 

4. Choose the processor from the “Select Processor Type” dialog box. 

5. Choose “AB_ETHIP-1” from the dropdown list “Driver”. 

6. Confirm with “OK”. 
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2.2 Channel Configuration 

 The IP settings in this example can cause serious network problems under 
certain circumstances. If you are in doubt about the correct IP settings for 
your network, ask your system administrator for assistance. 

1. Double-click on “Channel Configuration”. 

2. Select the tab “Channel 1”. 

3. Deselect “BOOTP Enable”. 

4. Enter “192.168.1.164” into the “IP Address” field. 

5. Enter “255.255.255.0” into the “Subnet Mask” field. 

6. Confirm with “OK”. 
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2.3 Create a New Subroutine 

1. Right-click on folder “Program Files” and execute command “New… ”. 

 
2. Enter “3” into the “Number” field. 

3. Enter “DRIVE1” into the “Name” field. 

4. Enter a device description. 

5. Confirm with “OK”. 

 

2.4 Create a Call of the Subroutine in the Main Ladder Program 

1. Double-click “LAD 2” in the folder “Program Files”. 

2. Insert a ladder rung. 

3. Double-click the rung to display the rung editor. 

4. Enter “JSR 3”. 

5. Press “ENTER”. 
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2.5 Create Data Files 

2.5.1 Create Data File Table N20 

1. Rigth-click on folder “Data Files” and execute command “New… ”. 

 

2. Make the settings according to the following table. 

Name Value 

File 20 

Type Integer 

Name DRIVE01 

Desc Drive01 Data Table 

Elements 89 

 

 
3. Confirm with “OK”. 
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2.5.2 Structure of Data File N20 

Data Table Address Description 

N20:0 Status Word 

N20:1 Actual Value LSW 

N20:2 Actual Value MSW 

N20:3 Digital Inputs Status 

N20:4 Control Word 

N20:5 Target Value LSW 

N20:6 Target Value MSW 

N20:7 Digital Outputs Control 

N20:8 Enable Configuration Assembly 

N20:9 P513 LED Functionality 

N20:10 P545 Service Interface Baud Rate 

N20:11 P769 Digital Output 1 Functionality 

N20:12 P771 Digital Outputs Polarity 

N20:13 P1025 Digital Input 1 Functionality 

N20:14 P1026 Digital Input 2 Functionality 

N20:15 P1027 Digital Input 3 Functionality 

N20:16 P1028 Digital Input 4 Functionality 

N20:17 P1030 Digital Inputs Polarity 

N20:18 P1537 Controller Parameter P 

N20:19 P1538 Controller Parameter I 

N20:20 P1539 Controller Parameter D 

N20:21 P1540 A-Pos 

N20:22 P1541 V-Pos 

N20:23 P1542 D-Pos 

N20:24 P1543 A-Rot 

N20:25 P1544 A-Inch 

N20:26 P1545 V-Inch 

N20:27 P1546 Pos Window 

N20:28 P1547 Gear Ratio Numerator 

N20:29 P1548 Gear Ratio Denominator 

N20:30 P1549 Spindle Pitch LSW 

N20:31 P1549 Spindle Pitch MSW 

N20:32 P1550 Calibration Value LSW 

N20:33 P1550 Calibration Value MSW 

N20:34 P1551 Software Limit 1 LSW 

N20:35 P1551 Software Limit 1 MSW 

N20:36 P1552 Software Limit 2 LSW 

N20:37 P1552 Software Limit 2 MSW 

N20:38 P1553 Delta Inch LSW 

N20:39 P1553 Delta Inch MSW 
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Data Table Address Description 

N20:40 P1554 Sense of Rotation 

N20:41 P1555 Pos Type 

N20:42 P1556 Operating Mode 

N20:43 P1557 Inching 2 Stop Mode 

N20:44 P1558 Inpos Mode 

N20:45 P1559 Loop Length 

N20:46 P1560 Contouring Error Limit 

N20:47 P1561 Current Limiting 

N20:48 P1562 Inching 2 Offset 

N20:49 P1563 Inching 2 Acceleration Type 

N20:50 P1564 Offset Value LSW 

N20:51 P1564 Offset Value MSW 

N20:52 P2338 PCM Position 1 LSW 

N20:53 P2338 PCM Position 1 MSW 

N20:54 P2339 PCM Position 2 LSW 

N20:55 P2339 PCM Position 2 MSW 

N20:56 P2340 PCM Position 3 LSW 

N20:57 P2340 PCM Position 3 MSW 

N20:58 P2341 PCM Position 4 LSW 

N20:59 P2341 PCM Position 4 MSW 

N20:60 P2342 PCM Position 5 LSW 

N20:61 P2342 PCM Position 5 MSW 

N20:62 P2343 PCM Position 6 LSW 

N20:63 P2343 PCM Position 6 MSW 

N20:64 P2344 PCM Position 7 LSW 

N20:65 P2344 PCM Position 7 MSW 

N20:66 P2370 PCM Acceleration 1 

N20:67 P2371 PCM Acceleration 2 

N20:68 P2372 PCM Acceleration 3 

N20:69 P2373 PCM Acceleration 4 

N20:70 P2374 PCM Acceleration 5 

N20:71 P2375 PCM Acceleration 6 

N20:72 P2376 PCM Acceleration 7 

N20:73 P2402 PCM Velocity 1 

N20:74 P2403 PCM Velocity 2 

N20:75 P2404 PCM Velocity 3 

N20:76 P2405 PCM Velocity 4 

N20:77 P2406 PCM Velocity 5 

N20:78 P2407 PCM Velocity 6 

N20:79 P2408 PCM Velocity 7 

N20:80 P2434 PCM Deceleration 1 

N20:81 P2435 PCM Deceleration 2 
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Data Table Address Description 

N20:82 P2436 PCM Deceleration 3 

N20:83 P2437 PCM Deceleration 4 

N20:84 P2438 PCM Deceleration 5 

N20:85 P2439 PCM Deceleration 6 

N20:86 P2440 PCM Deceleration 7 

N20:87 P2849 Configuration 

N20:88 P2850 Message Control Timeout 

N20:89 P3073 S Command 
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2.5.3 Create Data File Table B21 

1. Rigth-click on folder “Data Files” and execute command “New… ”. 

 
2. Make the settings according to the following table. 

Name Value 

File 21 

Type Binary 

Name DRIVE C/S 

Desc Control and Status Bits 

Elements 5 

 

 
3. Confirm with “OK”. 
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2.5.4 Structure of Data File B21 

Data Table Address Description 

B21:0 Control Word 

B21:0/0 OFF1 

B21:0/1 OFF2 

B21:0/2 OFF3 

B21:0/3 Intermediate Stop 

B21:0/4 Start Travel Job 

B21:0/5 Acknowledge Error 

B21:0/6 Inching Mode 1 

B21:0/7 Inching Mode 2 Positive 

B21:0/8 Inching Mode 2 Negative 

B21:0/9 Reserved, always 0 

B21:0/10 Relative Positioning 

B21:0/11 Reserved, always 0 

B21:0/12 Reserved, always 0 

B21:0/13 Reserved, always 0 

B21:0/14 Reserved, always 0 

B21:0/15 Reserved, always 0 

 

Data Table Address Description 

B21:1 Status Word 

B21:1/0 Supply 

B21:1/1 Readiness to Travel 

B21:1/2 Upper Limit 

B21:1/3 Lower Limit 

B21:1/4 Actuator Travels/Stands Still 

B21:1/5 Inpos 

B21:1/6 Active Travel Job 

B21:1/7 Fault 

B21:1/8 Operation Enabled 

B21:1/9 Switch-lock 

B21:1/10 Travel Job Acknowledgement 

B21:1/11 Battery Warning 

B21:1/12 Current Limiting 

B21:1/13 Reserved 

B21:1/14 Reserved 

B21:1/15 Reserved 

 

  



Example Ladder Logic Program 

AG25, AG26 Date: 02.06.2015  Mod. status V1.0 Page 14 of 28 

 

Data Table Address Description 

B21:2 Digital Inputs Status 

B21:2/0 Digital Input 1 

B21:2/1 Digital Input 2 

B21:2/2 Digital Input 3 

B21:2/3 Digital Input 4 

 

Data Table Address Description 

B21:3 Digital Outputs Control 

B21:3/0 Digital Output 1 

 

Data Table Address Description 

B21:4 Miscellaneous 

B21:4/0 Execute Configuration Assembly Read 

B21:4/1 Execute Configuration Assembly Write 
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2.5.5 Import Database for Data Files 

Together with the example project there is an additional database file supplied. The database 
file includes symbol information and description for data files N20 and B21. The file can be 
edited to make it suitable for your demands. 

1. Execute command “Tools” > “Database” > “ASCII Import”. 

 

2. Select “CSV”. 

3. Confirm with “OK”. 

 
4. Select the file “SIKO_AG2X_RSL500_SYMBOLS_V100.csv”. 

5. Open the file. 
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2.6 Create Ladder Logic 

2.6.1 Ladder Logic to Copy the Control Word 

1. Double-click “LAD 3” in the folder “Program Files”. 

2. Insert a ladder rung. 

3. Double-click the rung to display the rung editor. 

4. Enter the following text: 

COP #B21:0 #N20:4 1 

5. Press “ENTER”. 

 

2.6.2 Ladder Logic to Copy the Status Word 

1. Double-click “LAD 3” in the folder “Program Files”. 

2. Insert a ladder rung. 

3. Double-click the rung to display the rung editor. 

4. Enter the following text: 

COP #N20:0 #B21:1 1  

5. Press “ENTER”. 
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2.6.3 Ladder Logic to Copy the Digital Inputs Status 

1. Double-click “LAD 3” in the folder “Program Files”. 

2. Insert a ladder rung. 

3. Double-click the rung to display the rung editor. 

4. Enter the following text: 

COP #N20:3 #B21:2 1  

5. Press “ENTER”. 

 

2.6.4 Ladder Logic to Copy the Digital Outputs Control 

1. Double-click “LAD 3” in the folder “Program Files”. 

2. Insert a ladder rung. 

3. Double-click the rung to display the rung editor. 

4. Enter the following text: 

COP #B21:3 #N20:7 1  

5. Press “ENTER”. 
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2.6.5 Ladder Logic to Send the Message Control Timeout 

 The IP settings in this example can cause serious network problems under 
certain circumstances. If you are in doubt about the correct IP settings for 
your network, ask your system administrator for assistance. 

 

 Set the Message Control Timeout value to a non-zero value. This value need 
to be set between 5000 and 20000 milliseconds. The value is stored in 
volatile memory. Anytime the drive is power cycled this timeout value must 
be re-written again. If the value is set to zero the process data output 
message will be ignored. The drive will issue a drive fault if a message is 
not received from the controller within the specified time 

1. Double-click “LAD 3” in the folder “Program Files”. 

2. Insert a ladder rung. 

3. Double-click the rung to display the rung editor. 

4. Enter the following text: 

XIO MG10:0/EN MSG MG10:0 

5. Press “ENTER”. 

6. In the MSG instruction, double-click “Setup Screen” to launch the message configuration 
dialog box. 

7. Configure the input fields of the “General” tab. 

8. Configure the input field “To Address” of the “MultiHop” tab. 

General Tab: This Controller Setting 

Channel 1 (Integral) 

Communication Command CIP Generic 

Data Table Address (Send) N20:88. P2850 Message Control Timeout 

Size in Bytes (Send) 2 

General Tab: Target Device Setting 

Extended Routing Info File (RIX) RIX9:0. An unused extended routing information file  

Service Generic Set Attribute Single 

Class (hex) A2 

Instance (hex) B22 

Attribute (hex) 5 

MultiHop Tab Setting 

To Address 192.168.1.165. The IP address of the drive. 
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2.6.6 Ladder Logic for Process Data Output 

 The IP settings in this example can cause serious network problems under 
certain circumstances. If you are in doubt about the correct IP settings for 
your network, ask your system administrator for assistance. 

This message writes the Control Word, Target Value and Digital Output Control. 

1. Double-click “LAD 3” in the folder “Program Files”. 

2. Insert a ladder rung. 

3. Double-click the rung to display the rung editor. 

4. Enter the following text: 

BST XIC MG10:0/DN NXB XIC MG10:0/ER BND XIO MG10:1/EN MSG MG10:1 

5. Press “ENTER”. 

6. In the MSG instruction, double-click “Setup Screen” to launch the message configuration 
dialog box. 

7. Configure the input fields of the “General” tab. 

8. Configure the input field “To Address” of the “MultiHop” tab. 

9. Close the message configuration dialog box. 

General Tab: This Controller Setting 

Channel 1 (Integral) 

Communication Command CIP Generic 

Data Table Address (Send) N20:4. Storage location of process data output  

Size in Bytes (Send) 7 

General Tab: Target Device Setting 

Extended Routing Info File (RIX) RIX9:1. An unused extended routing information file  

Service Write Assembly 

Class (hex) 4  

Instance (hex) 96 

Attribute (hex) 3  

MultiHop Tab Setting 

To Address 192.168.1.165. The IP address of the drive. 
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2.6.7 Ladder Logic for Process Data Input 

 The IP settings in this example can cause serious network problems under 
certain circumstances. If you are in doubt about the correct IP settings for 
your network, ask your system administrator for assistance. 

This message reads the Status Word, Actual Value and Digital Inputs Status. 

1. Double-click “LAD 3” in the folder “Program Files”. 

2. Insert a ladder rung. 

3. Double-click the rung to display the rung editor. 

4. Enter the following text: 

BST XIC MG10:1/DN NXB XIC MG10:1/ER BND XIO MG10:2/EN MSG MG10:2 

5. Press “ENTER”. 

6. In the MSG instruction, double-click “Setup Screen” to launch the message configuration 
dialog box. 

7. Configure the input fields of the “General” tab. 

8. Configure the input field “To Address” of the “MultiHop” tab. 

9. Close the message configuration dialog box. 

General Tab: This Controller Setting 

Channel 1 (Integral) 

Communication Command CIP Generic 

Data Table Address (Receive) N20:0. Storage location of process data input.  

Size in Bytes (Receive) 7 

General Tab: Target Device Setting 

Extended Routing Info File (RIX) RIX9:2. An unused extended routing information file  

Service Read Assembly 

Class (hex) 4  

Instance (hex) 64 

Attribute (hex) 3  

MultiHop Tab Setting 

To Address 192.168.1.165. The IP address of the drive. 
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2.6.8 Ladder Logic to Read the Configuration Assembly 

 The IP settings in this example can cause serious network problems under 
certain circumstances. If you are in doubt about the correct IP settings for 
your network, ask your system administrator for assistance. 

The Configuration Assembly structure corresponds with the data table address range 
N20:8 … N20:89. 

1. Double-click “LAD 3” in the folder “Program Files”. 

2. Insert a ladder rung. 

3. Double-click the rung to display the rung editor. 

4. Enter the following text: 

XIC B21:4/0 MSG MG10:3 

5. Press “ENTER”. 

6. In the MSG instruction, double-click “Setup Screen” to launch the message configuration 
dialog box. 

7. Configure the input fields of the “General” tab. 

8. Configure the input field “To Address” of the “MultiHop” tab. 

9. Close the message configuration dialog box. 

General Tab: This Controller Setting 

Channel 1 (Integral) 

Communication Command CIP Generic 

Data Table Address (Receive) N20:8. Configuration Assembly start address.  

Size in Bytes (Receive) 164 

General Tab: Target Device Setting 

Extended Routing Info File (RIX) RIX9:3. An unused extended routing information file  

Service Read Assembly 

Class (hex) 4  

Instance (hex) 5 

Attribute (hex) 3  

MultiHop Tab Setting 

To Address 192.168.1.165. The IP address of the drive. 
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2.6.9 Ladder Logic to Write the Configuration Assembly 

 The IP settings in this example can cause serious network problems under 
certain circumstances. If you are in doubt about the correct IP settings for 
your network, ask your system administrator for assistance. 

The Configuration Assembly structure corresponds with the data table address range 
N20:8 …  N20:89. 

1. Double-click “LAD 3” in the folder “Program Files”. 

2. Insert a ladder rung. 

3. Double-click the rung to display the rung editor. 

4. Enter the following text: 

XIC B21:4/1 MSG MG10:4 

5. Press “ENTER”. 

6. In the MSG instruction, double-click “Setup Screen” to launch the message configuration 
dialog box. 

7. Configure the input fields of the “General” tab. 

8. Configure the input field “To Address” of the “MultiHop” tab. 

9. Close the message configuration dialog box. 

General Tab: This Controller Setting 

Channel 1 (Integral) 

Communication Command CIP Generic 

Data Table Address (Receive) N20:8. Configuration Assembly start address.  

Size in Bytes (Receive) 164 

General Tab: Target Device Setting 

Extended Routing Info File (RIX) RIX9:4. An unused extended routing information file  

Service Write Assembly 

Class (hex) 4  

Instance (hex) 5 

Attribute (hex) 3  

MultiHop Tab Setting 

To Address 192.168.1.165. The IP address of the drive. 
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2.7 Verify and Download Project 

1. Execute command “Edit” > “Verify Project”. 

2. Debug project if necessary. 

3. If the project is error free you can download the project. 

2.8 Read the Configuration Assembly 

1. Go online. 

2. Double-click data file “B21” in the folder “Data Files”. 

3. Double-click data file “N20” in the folder “Data Files”. 

4. Set bit B21:4/0 “Execute Configuration Assembly Read”. 

 

2.9 Write the Configuration Assembly 

1. Go online. 

2. Double-click data file “B21” in the folder “Data Files”. 

3. Double-click data file “N20” in the folder “Data Files”. 

4. Set parameter N20:8 “Enable Configuration Assembly” to 1. 

5. Ensure that the data file addresses N20:9 … N20:89 are set up with valid values. You can 
read the Configuration Assembly in advance to fill up N20:9 … N20:89 with valid values. 

6. Set bit B21:4/1 “Execute Configuration Assembly Write”. 
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